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Introduction

Welcome to the ENTELIS+ training manual. The aim of this document is to help

the ENTELIS+ trainers to provide the highest quality training that is easily

accessible to all participants, guiding them through the process, right from the

preparation phase all the way to the training itself. This ENTELIS+ training

materials are divided into two main elements:

Section I: Training manual

This document focuses on the preparation of the ENTELIS+ training and all of the

different aspects that should be taken into account to ensure an accessible

and successful training programme. It covers the following issues:

● A flexible approach to learning accessibility

● Face to face training

o Getting there

o Preparing the room

o Let the user decide the format

o Teaching strategies

o Online training

● Choosing an accessible video conferencing tool

o Key accessibility issues to take into account when carrying out

online training

o Accessible digital formats

o Accessible documents
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Section II: Training modules

These documents focus on guiding the trainer on how to get the most out of

the learning materials provided. These materials will provide additional

information sources for the training and ideas on different ways to teach the

material. A support guide is provided for each of the 5 ENTELIS+ training

modules:

● Basic Level: An introduction to accessibility

● Basic level: Empowerment of People with Disabilities through human

rights

● Advanced level: Assistive Technology (AT)

● Advanced level: Creation of accessible resources to support

teaching and learning

● Advanced level: Roadmap for professional development in ICT

accessibility
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1. A flexible approach to learning accessibility

The ENTELIS+ training modules have been designed in such a way to be as

flexible as possible for the training organisation implementing the programme.

The onset of the COVID-19 pandemic and the uncertainty around the possibility

of carrying out face to face courses in the near future means that training

materials now have to be adaptable to different settings, both online and

offline. Taking all of these factors into account, the ENTELIS+ training materials

have been defined with the following ideas in mind:

● Online or face to face learning: The learning materials have been

designed in such a way that they can be taught face to face, online

or through blended learning. This decision will fall with the training

organisation and will also take into account the current situation with

regards to the COVID-19 pandemic. Instructions on how to carry out

the training in each way have been provided.

4



The contents of this document are confidential. Reproduction or forwarding without written approval from the ENTELIS+
Consortium is forbidden.

● Heterogeneous target audience: as the different organisations

implementing the training may have different priorities regarding the

target audience and varying set ups, prerequisites, backgrounds and

resources, the materials have been produced as a baseline that can

be flexible and dynamic and that can be moulded to suit the best

interests of each organisation.

● Guided vs self-learning: The training modules can be used for both

guided and self-learning or a mixture of these two approaches. The

training modules provide guidance to potential trainers on how to

teach the materials. Exercises and further reading materials have also

been included to promote self-learning and to the student’s

knowledge into action. However, the modules are also accessible

should students wish to read and learn by themselves.

● Tiered approach: The modules have been divided into basic and

advanced modules. The basic modules provide an introduction to

accessibility for those students who may not have any prior

knowledge on the subject. The advanced modules go into greater

depth on accessibility and its different elements. Whilst the ENTELIS+

project recommends that training starts on the basic modules and

then progress onto the more advanced modules, this is not

obligatory.

● Off the shelf: The modular approach to the ENTELIS+ training materials

means that teachers or students can choose the modules that are of

most interest to them. It is strongly suggested however, that the

module “Advanced level: Roadmap for professional development

and potential professional certifications in ICT accessibility” be

addressed as the final module. This is because it provides information

on how to become an ENTELIS+ trainer and includes access to

additional reading materials, something that should only be the focus

of students who have studied the other four modules first.
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● Multimodality: The training materials combine a wide range of

training materials including written, images and videos.

● Real life examples: Where possible real-life examples of how

accessibility is being implemented have been included throughout

the training materials. These can be seen in the “Accessibility in

action” extracts. The idea is to enhance the message that is being

transmitted to the student by providing tangible examples where

accessibility has been successfully implemented.

Finally, it should be mentioned that a proposed duration of the ENTELIS+ training

programme has not been specified. This has been omitted on purpose. This is

because the duration of the training programme will differ a great deal on the

choices the local pilot organisation makes to implement the training and on

their specific needs. The duration should be sufficient so as not to overload the

participants in the training course. It should also be adapted according to the

type of participants being addressed.
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2. Face to face training

Whilst the current COVID-19 pandemic has made meeting in groups very

difficult, face to face training still remains an essential and effective way of

carrying out training programmes on accessibility. It is simply a case of time until

covid-secure face to face training will be able to be carried out again. It has

therefore been included in this guide as a potential way to carry out the

ENTELIS+ training.

These are the aspects that need to be considered when preparing a

face-to-face training programme or individual sessions.

2.1 Getting there
How do you make sure participants are able to reach the training?
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2.1.1 Providing directions in an accessible manner
If you know your participants beforehand, you can of course ask for their

preferences and then send exactly the information they need, in exactly the

format they prefer. But if you don’t know them, you need to make sure that the

information is accessible when it comes to both content and format.

2.1.2 Content
Try to describe how to get to the training venue without relying only on visual

cues. It is usually better to say, “take the second street to the right” than to say,

“turn right at the big blue house”.

Remember to describe the surface; is this a road with asphalt, a sidewalk or a

path with sand or gravel?

If possible, describe a way that supports audio and tactile orientation; walking

alongside a building is usually easier than crossing an empty square.

Describe if there is reserved parking for community transport like taxis or busses

near the building and how far away from the entrance these are.

2.1.3 Accessibility in the approach
Make sure that entrances and redirections are clearly marked with large, high

contrast signs and illustrations for cognitive support. Braille usually does not work

very well outdoors, as users are not expecting objects to contain Braille. In some

circumstances, good visibility on signs can be provided by having the ordinary

text being tactile (standing out from the background).

Try to place the signs leading up to the training venue at a distance where the

next one is visible from where the user stands reading the first, and/or provide

directions as to where the next sign is to be found, to facilitate.

Make sure stairs and other obstacles are marked with contrast marking.
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2.2 In the building
In the entrance, provide clear marking on glass doors and other transparent

items so that visually impaired users do not get hurt.

Walk through the building from the entrance to all the rooms where participants

may need to go: the room where training is going to take place, to the toilets,

the wardrobe, the kitchen or where coffee is served etc.

Choose a path that avoids obstacles. Provide a description of the path in the

materials delivered to the participants.

Remove loose objects and make sure there is something blocking the way

under hanging cabinets and shelves, so that visually impaired persons don’t

walk right into them.

Indicate routes and stairs with high contrast markings and large signs.
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If the building is large, provide a large print (and if possible tactile) map or

consider providing a companion to show the way. It may be enough to

accompany the person once or twice, until the route is memorised.

2.3 Preparing the room
How do you make the room accessible for the visually impaired?

2.3.1 Furniture and placement
Make sure visually and hearing-impaired participants get to choose where to

sit, in the front is usually a good place. But as preferred light, angle to the board

etc can be individual depending on specific impairment, it is better to let the

individual decide. For example, macular conditions affect central vision,

meaning participants may appear to be looking out of the window because

they are using their peripheral vision.

When you stand in front of the class, avoid being in front of strong light, such as

a window, as this will mean you are in a shadow and it gets hard to see your

facial expression.

Whiteboards may be difficult to distinguish because they are located on white

walls. The outline framing of whiteboards should be in a contrasting colour for

participants (particularly the visually impaired) to be able to identify the board

from the wall. Similarly, it is important to use chalk or markers that have a strong

contrast with the board.

Be aware of the effect of lighting and reflections on white boards, both from

natural light and lamps.

2.3.2 Lighting
General lighting should be bright and even, without causing glare. If the

general lighting is hard to change, individual task lighting can be useful. Ensure

all activity and internal areas are well lit at 250-300 lux and positioned to

facilitate reading and other activities. Corridors and staircases require a

minimum lighting of at least 100 lux. Shaded light fixtures such as compact

fluorescent lights (CFL) or those using light-emitting diodes (LED) aimed
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downward are recommended. Trainers should take into account other aspects

such as the natural light in the room and the use of window blinds or curtains.

2.3.3 Acoustics
Good acoustics are important for all participants, and of course especially for

hearing impaired. As visually impaired participants can’t get the same

information through their eyes as sighted users, audio is also key to this group.

Other groups, like for example neurodiverse or brain injured, also tend to be

sensitive to noisy spaces or unpredicted sounds.

Avoid background noise. Require participants who use screen readers or other

audible assistive technology to use headphones, to avoid disturbing others.

In larger rooms, microphones, speakers and induction loops are necessary.

2.4 Let the user decide the format
If possible, provide information in black print, large print, braille, audio and

digital formats. This way you are covering many different ways to perceive

information.
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2.4.1 Information on paper
For blind users, information on paper is not possible to read, but some/many

users have the possibility to scan the paper and have their phone or computer

read the information out loud to them. For this to work, the information must be

produced in text, not an image of a text. There are also manual services where

the blind user can send a fax or similar to a specific service where a sighted

person reads the content back to the user.

For most visually impaired users, information on paper can be read as long as

the contrasts are good enough and the text size is large enough.

2.4.2 Colour contrast
As visual impaired users may have individual difficulties with certain

combinations of colors, it is hard to make everyone happy. Information on

paper is therefore recommended to be provided in black and white.

2.4.3 Typography
Avoid italics and capital letters. These are less readable not only to visually

impaired users but to all of us.

Leave reasonable space between lines of type. The exact space

recommended depends on line length and on the x-height of the font you are

using. A rule of thumb can be to add 25 to 30 percent of the text point size

between lines.

Line lengths should ideally be in the range of 50–65 characters. Some visually

impaired people may prefer even shorter lines than this. Avoid splitting words at

the ends of lines. Do not use justified text.

2.4.4 Fonts
The choice of font is less important than contrast, text size and spacing of

characters. The favourite fonts of users are very individual and have to do not

only with the visual ability but also habit. A “new” or unusual font is often

perceived as harder (or slower) to read. Before the digital revolution of assistive

technology, it was commonly thought that sans serif fonts (without “feet”: like

Arial) were easier to read than serifed fonts (with “feet”: like Times New Roman).
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However, there is no valid research to support this when it comes to reading on

a screen.

2.4.5 Text size
The size of a font is described in point size. Regular print is usually 10 or 12 point.

Large print is generally 14-to-18-point size. Giant print is anything larger than this.

Remember that different types with the same ‘point size’ have different

appearing sizes. The effective size of a typeface is actually related to the height

of the lowercase x.

2.4.6 Digital information
If invitations to the training are sent out in digital format, it needs to be

technically accessible so that users with assistive technology can read,

navigate and use it no matter if they are using a screen reader, magnification

or other kind of tools. You can learn more about how to make digital

information accessible in the “Advanced Module: Creation of accessible

resources to support teaching and learning”.

2.4.7 Text in digital format
Structure your text well, using content tables and headings. This will help it be

read out loud and navigated by screen readers or other assistive technologies,

maintaining the logical order embedded in the text.

For online texts, use the fonts specially designed for reading on a screen, like

Verdana, Tahoma and Trebuchet MS. Always allow the user to change font

and point size as needed in online texts.

Left align text instead of using block text (full justification). Use ‘Bullets and

Numbering’ functions for lists. Add short summaries of content or chapter where

possible.

Ensure that colours and the use of bold and italics are not your only method of

conveying meaning. Ensure that all information conveyed with colour is also
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available without colour. Do not rely on colour alone to highlight different

content.

Give data tables row and column headers and describe their content in a

summary.

2.4.8 Low tech audio
There may be some, specifically elderly or people who have recently become

visually impaired, who are not used to web-based information and/or assistive

technology. These users may have the opportunity to use different kinds of

audio, like Daisy players, CD or even tape recorders. It is also possible to record

a message on an answering machine where the users can call in and get

instructions.

2.5 Teaching strategies
Always address participants with their name. For example, for visually impaired

students, this way they will know you are talking to them and not someone else.

For example, when passing in a crowded hallway, say “Hi Sara, it’s John, how

are you today?”.

When writing on the board, always read out loud what you are writing so that

participants can follow along. Try to use positional and directional concepts like

above/under, on top, behind/in front of, left/right etc. and use descriptive

sentences like, “The ball is next to the door” instead of “The ball is over there.”

When using words and phrases like “here,” “there,” “over here,” “over there,”

and gestures that provide direction, (for example pointing to a location), make

sure to also describe what you are pointing at so that visually impaired

participants know what you mean.

The self-motivation of the learners is key. Teaching strategies should focus on

providing opportunities and challenges that attract the learners’ personal

interest in order to create the right conditions for participation and adaptability

according to the person's needs and wishes.
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3. Online training

The onset of the COVID-19 pandemic has changed the way we live and work.

Many activities that were once carried out face to face have now moved

online to reduce physical contact, including the provision of training courses

and programmes.

There are many advantages of carrying out training online if the user has the

correct tools in place. However, with the wrong tools, some user groups,

particularly people with disabilities may encounter many new barriers.

In this chapter, we highlight different aspects of online training so that you can

make it as accessible as possible for your target audience.

3.1 Choosing an accessible video conferencing tool
One the most important decisions to make when moving from face to face to

online training is which video conferencing or collaboration tools to use.
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The aim of this chapter is not to point you to one specific video conferencing

tool, but to highlight the different features of the main video conferencing tools

in terms of accessibility. This is not an exhaustive list and the decision is left to the

pilot site implementing the training programme. Whilst some smaller studies

have been carried out prior to and during the COVID-19 pandemic, the

consortium does not consider them to be comprehensive enough to show the

full picture. Furthermore, the tools and systems are being changed and

updated constantly, so information becomes obsolete quickly and preferences

may differ between user groups. A good way to access up to date information

about a tool’s accessibility policy is through their accessibility statement, usually

found at the bottom of their webpage.

An accessible video conferencing system is when the system has a built-in

functionality to provide closed captions, the possibility to highlight sign

language interpreters, and works for people using assistive technology for both

input and output.

Even simple tasks such as joining an online meeting or training session can be

difficult if the system you are using has not been developed with accessibility in

mind. For example, the launch of various, unnecessary preference dialogues

when entering a system can block a blind person that is using a screen reader.

The level of familiarisation of the target audience with the online training tools

should also be taken into account when choosing one of the video

conferencing tools. The list below is presented in alphabetical order.

Sources:

Which Video Conferencing Tools Are Most accessible, Smashing Magazine,

15/06/2020

Best video conferencing apps and software for accessibility”,The big Hack,

08/04/2020
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3.1.1 Google Meet
Google Meet offers automatic captioning in English and the possibility for live

captions. The solutions is compatible with magnifiers and screen readers and

includes a built-in screen reader, full page zoom, high contrast colour and

accessibility extensions in the Chrome browser. Google Meet also provides

keyboard shortcuts for accessibility features, microphone and camera options.

Google Meet

3.1.2 GoToMeeting
GoToMeeting offers a high contrast mode and is easy to navigate using the

keyboard. It also offers the possibility for live captions. It was one of the first tools

that offered good support for sign language interpretation.

GoToMeeting

3.1.3 One to one/One to few video calls
Whilst perhaps not the most appropriate tools for a group training session, video

calls also offer a great opportunity to carry out one to one / one to few video

calls. These could be used for example for specific tutoring sessions,

troubleshooting or collaborative work between students. Apps such as

FaceTime, WhatsApp and Skype offer this capability.

These apps are particularly useful for those students and teachers who

communicate using sign language.

3.1.4 Microsoft Teams
Microsoft Teams is available to those training organisations that have an Office

365 license although others can be invited. It is integrated into other office apps

facilitating calendar and file sharing. The video calls through Teams allow the

user to include hundreds of participants and offers automatic captioning in

English and the possibility for live captions.

Microsoft Teams
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3.1.5 Slack
Slack is a very popular app that allows the user to maintain conversations and

chats with other users throughout the day. It is particularly good for

spontaneous video conversations that could be beneficial for quick

trainer-student tutorials or student-student collaborative work. Furthermore, the

application also has large bold buttons and resizable text that are great for

users with low vision.

Slack offers the possibility for live captions.

However, Slack can also present some accessibility issues. For example, the

interface can present problems for users of assistive technology and keeping

track of which slack community you are working in when the user interface is

magnified can be difficult.

Slack

3.1.6 Webex
Webex has a bold visual design which can be quite useful for sighted and

low-vision users who can use a mouse. It works particularly well when using

screen magnifying software. Also, the settings are quite intuitive and easy to

figure out. It also automatically can detect background noise to remove

distractions.

However, Webex often launches pop-up dialogues when a user enters a

meeting which cannot be operated without a pointing device. It also presents

problems for screen reader users, as many of its interface elements have

missing or confusing labels and other cannot be reached without a keyboard.

Webex offers the possibility for live captions.

Webex
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3.1.7 Zoom
Zoom is a video conferencing tool that offers automatic captioning in English

and the possibility for live captions. The support for sign language has been

improved. .

In the downloaded version, Zoom can be tailored to the user’s needs through

the extensive settings menu, including settings for the blind and low-vision users.

In total, zoom offers 70 settings on the desktop client and a further 95 available

through the advanced settings feature.

Not all the accessibility features are available if you use the browser version of

Zoom, and as not all organisations allow downloading the desktop client, this

may cause problems for users with disabilities.

Zoom

3.2 Key accessibility issues to take into account when carrying out online

training
Once you have chosen your online training/video conferencing tool, there are

various tips that you can follow to ensure a more accessible experience for all

of our students. Online meetings can be very tiring as you are not able to see

and interact with the other participants in the same way as you can in

face-to-face meetings. It is therefore important to understand this and ensure

that you programme in breaks at regular intervals. It is also important to engage

with the participants by stopping, asking questions or carrying out a group

exercise. This is important for all students but particularly for neurodiverse

students.

Before starting the online training sessions, please consider the following points:

● Pace: if the training or discussion moves too quickly, it can be

inaccessible to some students. When using videoconferencing tools,

such as those described above, there can be a lot of things going on

(audio, visual, chat etc.). Please be aware of this and adapt the

pace to your group’s requirements. Additional tips may include:
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o Check in on people’s understanding throughout the training

and reiterate key points at regular intervals.

o Ensure that participants speak one at a time.

o Ask students to request their turn to speak by using the “raise

the hand” function (Zoom) or by alternative ways such as the

chat box.

o Record the meeting (always seeking prior permission from all

students). This can be shared afterwards and will allow

participants to go back and listen to the important points

again afterwards.

o Ensure that you include the appropriate number of breaks for

long sessions.

● Audio: A training session involving many students may be noisy and

quite hard to follow. Try and keep the online training groups to a

minimum number of students. Additional tips include:

o Ask students to turn off their audio when they are not

speaking.

o Consider using an external mic if you are hosting the meetings

in order to improve sound quality.

o Use a video conferencing system that supports

subtitles/captioning (see previous section).

o For captions, speak clearly and try to limit background noise.

o If you are using slides, try to share your notes or transcript so

that students can read along as you present.

● Visual: Visual images on all slides is helpful for everyone, especially

those who need support reading or communicate through images or
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pictures. However, these visual images or slides need to be verbally

explained in some form. Additional tips include:

o When using slides, read out the content of the slide or describe

images.

o Before starting and depending on the size of the group, ask all

participants to introduce themselves and describe them and

their environment.

o If you are sharing a website, include the link to the website in

the chat so students can access and read through

themselves.

o Share any documentation that will be presented prior to the

training so that visually impaired people have time to go

through it with their screen reading software.

● No online access: not everyone has an internet connection at home,

or some people may live in rural areas where the connection is too

weak to support video conferencing facilities. It is always good to

offer an alternative, such as joining by phone in these cases.

Source: Accessibility in Video Conferencing and remote Meetings, Drake

Music, 26/03/2020

3.3 Accessible digital formats
Once you have chosen the tool you will be using to carry out the training, it is

time to ensure that the digital materials you will be using during the training are

accessible for all students.

How do you ensure that digital formats work for the visually impaired/the blind?

Productivity applications are a category of application programmes that help

users produce things such as documents, databases, graphs, worksheets and

presentations. This section includes the accessibility features of the most
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common productivity application in Microsoft Office (Word, PowerPoint and

Excel).

The main features of Microsoft software include tools for people who are blind,

colour blind, or have low vision:

Microsoft accessibility for visually impaired

These are useful links for accessibility tools in Windows:

● Windows 10 Accessibility Tools

● Accessibility support for Word (Windows, macOS, iOS, Android,

Windows 10 app and Web)

● Accessibility support for PowerPoint (Windows, macOS, iOS, Android,

Windows 10 app and Web)

● Accessibility support for Excel (Windows, macOS, iOS, Android,

Windows 10 app and Web)

3.4 Checking that content is accessible
Whilst information on how to create accessible content is provided in the

training modules later on in this document, it is also useful to know that there are

easy ways to check the accessibility of your documents before you start using

them in class.

Below, the steps to use the accessibility checkers in Word, PowerPoint, Excel

and PDF have been detailed.

3.4.1 Accessibility checker in Word
1. Select File > Info.

2. Select the “Check for Issues button” in the “Inspect Document” area.

3. Click the “Check Accessibility” command to launch the task pane.

4. A list of “Errors” and/or “Warnings” may appear.
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3.4.2 Accessibility checker in PowerPoint
1. Select File > Info.

2. Select the “Check for Issues button” and choose “Check Accessibility”.

3. In the Check for Issues drop-down menu, select Check for Issues.

4. Select the “Review tab”, then choose “Check Accessibility”.

3.4.3 Accessibility checker in Excel
1. Select File > Info.

2. Select the Check for Issues button.

3. In the Check for Issues drop-down menu, select Check for Issues.

4. The Accessibility Checker task pane appears next to your content and

shows the inspection results.

3.4.4 Accessibility checker in PDF (Acrobat Reader)

1. Open the document.

2. Add the Accessibility Tool to your Toolbar: Click on the Tools Tab > Click

the Add button below the Accessibility Tool.

3. Return to Document View: Click on the Document Tab.

4. Open the Accessibility Toolbar: Click on the Accessibility Tool in the

Toolbar on the right side of the window.

5. Run a Full Check of the document: Click on Full Check in the Accessibility

Toolbar on the right side of the window > Click on Start Checking to run

the Accessibility Checker.

6. View the results:

a. The Accessibility Checker panel will be opened on the left side of

the window.

b. Click on each category to expand that section:
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7. A green checkmark indicates that the test was passed.

8. A red X indicates that the test was failed.

9. A blue question mark indicates that the test must be done manually.

a. Some items can be fixed automatically by Acrobat, and some will

need to be fixed manually.

b. Right-click on each item to see if they can be automatically fixed.

10. If the item cannot be fixed automatically, click on Explain to open the

item's section in the Acrobat User Guide.

11. You will find a description of the reported issue and directions on how to

fix it.

3.4.5 Accessibility checker in PDF (Adobe Pro DC)
1. Start by selecting Accessibility Tools.

2. Select Full Check command from the Accessibility Tools panel to open

the Accessibility Checker Options dialogue, select the Report Options to

save the results as an HTML file or attach the report to the document.

3. Use the default “All Pages” to check all pages or select a page range to

check on individual sections of a document.

4. Select a Category of Document, Page Content, Forms, Tables and Lists,

or Alternate Text and Headings to modify the accessibility Checking

Options. By default, everything but “tables must have a summary” is

checked.

5. Select the Start Checking button to begin the full check

3.5 Online teaching strategies
As in face-to-face teaching environments, it is also important to take into

account accessibility when providing training online. Always address

participants with their name to ensure that they know who is being spoken to.
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When giving a virtual presentation, always read out loud what is written in your

presentation so that participants can follow along.

As in face-to-face environments, the self-motivation of the learners is key.

Teaching strategies should focus on providing opportunities and challenges

that attract the learners’ personal interest in order to create the right conditions

for participation and adaptability according to the person's needs and wishes.
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